
 

Alignment of Tools 
LEAP 2025 Online Assessment Tools & the Kurzweil 3000 Text-to-Speech Technology  

 
Many of the LEAP Accommodations and Accessibility Features available in the computer-based tests are very similar to features and tools 
found in Kurzweil 3000.   
 
On the following pages, you’ll see a side-by-side comparison of many of the LEAP Accommodations and Accessibility Tools and some of the 
features/tools found in Kurzweil 3000 which are very similar.  Giving students access to Kurzweil 3000 throughout the school year can help them 
to become familiar with and comfortable in the use of tools such as text-to-speech, sticky notes, highlighters, magnifiers and much more.   The 
following pages will show the ways in which tools in Kurzweil 3000 Desktop Software and Kurzweil3000.com align with many of the 
accommodations on statewide tests.  
 
Below are some links that you may find helpful: 
 

 LEAP Accommodations and Accessibility Features User Guide: 
 http://www.louisianabelieves.com/docs/default-source/assessment/leap-accessibility-and-accommodations-manual.pdf?sfvrsn=10 

 
 

 LEAP 2025 and other Online Practice Tests: https://wbte.drcedirect.com/LA/portals/la)  
 

 Grades 3 & 4 ELA & Math Paper & Pencil Tests in Kurzweil format: http://www.louisianabelieves.com/resources/library/practice-tests 
 

 IEP Accommodations Page (see page 5) with Kurzweil listed as an accommodation under “Read Aloud:”  
http://www.louisianabelieves.com/docs/default-source/assessment/iep-forms.pdf?sfvrsn=14 

 

 Login Screen for the Kurzweil3000.com: www.kurzweil3000.com 
 

 Kurzweil 3000 Desktop Software Download/Installation Instructions 
o Windows: https://www.kurzweiledu.com/files/v15win/kurzweil_3000_wl_win_install.pdf 
o Mac: https://www.kurzweiledu.com/files/v15mac/kurzweil_3000_wl_mac_install.pdf  

 

 Kurzweil3000 Getting Started Guides are available under the Help Tab of Kurzweil3000.com and on our Product Guides page: 
https://www.kurzweiledu.com/products/product-guides.html 

 

http://www.louisianabelieves.com/docs/default-source/assessment/leap-accessibility-and-accommodations-manual.pdf?sfvrsn=10
http://www.louisianabelieves.com/docs/default-source/assessment/leap-accessibility-and-accommodations-manual.pdf?sfvrsn=10
https://wbte.drcedirect.com/LA/portals/la
http://www.louisianabelieves.com/resources/library/practice-tests
http://www.louisianabelieves.com/docs/default-source/assessment/iep-forms.pdf?sfvrsn=14
http://www.kurzweil3000.com/
https://www.kurzweiledu.com/files/v15win/kurzweil_3000_wl_win_install.pdf
https://www.kurzweiledu.com/files/v15mac/kurzweil_3000_wl_mac_install.pdf
https://www.kurzweiledu.com/products/product-guides.html


 

LEAP 2025 Online 
 

Kurzweil 3000  

LEAP 2025 Online  
Text-to-Speech 

 

 
 

To have LEAP 2025 Online read out loud, the student 
clicks the “Play” icon. While reading, the Play button 
becomes a Pause button, as shown below. 
 

 
 

The round button in the center is “Starting Points,” which 
is used for navigation within the document. 

Kurzweil 3000 Desktop  
 Text-to-Speech 

 
 

 
 
The Kurzweil 3000 “Read (or Play)” button is always present. To have text read aloud, the 

student clicks the read  button. As it’s reading, the Play becomes Pause , which the 
student would click to stop the reading.  Alternatively, the student  can  click on the page to stop 

reading. Use the front/back arrows  to move forward/back by reading unit.  The student  
can also click on the page where they want to start reading, click read and it will begin reading at 

that location. To hear single words spoken,  double click on the word. The   toggles audible 

speech on/off.  In the silent reading mode  , K3000 will continue to “read” the document and 
will highlight asit reads, it will just do so silently.  
 
 

Kurzweil3000.com :  the Reading control buttons are the similar.  Other tools in the 
Kurzweil3000.com toolbar are explained under the following sections.  
 
 

 
 



 

LEAP 2025 Online 
Audio Options 

 

 
To change LEAP 2025 Online audio options, the student 
clicks the “Options” button, then select “Audio Options.”  
An audio settings tool window pops up (shown below). 
From there, the student can change reading volume and 
speed.  LEAP 2025 Online currently has one voice 
available. 

 
 

LEAP 2025 Online 
Audio Options (continued) 

 

 
 

He She also has the option of toggling on/off the “follow 

along” highlighting as it reads.  

Kurzweil 3000 Desktop 
Audio Options 

 
 

 
 
 
To change Kurzweil 3000 Desktop audio options, the student clicks the “Audio Options” menu. 
An Audio Options drop down menu allows users to adjust the reading speed by words-per-
minute (WPM). Additional reading options available in Kurzweil 3000: choice of reading voices, 
mode, reading unit, and reading language. (Note: Volume is changed at the computer, not in the 
K3000 program.) 

 

Kurzweil3000.com: the ability to customize reading is found in Audio Options   

 



 

LEAP 2025 Online  
Zoom/Magnifier 

 

 
To change LEAP 2025 Online zoom options, the student 
clicks the “Magnifier” icon. A zoom settings tool window 
pops up (shown below). From there they can change 
zoom and use arrow keys to move across the page. 

 

Kurzweil 3000 Desktop 
 Zoom 

 

 
 
 
 

To change the zoom, click the  Zoom in or Zoom out . Students can also choose a preset 
zoom value via the Zoom drop-down menu. 
 
  

Kurzweil3000.com Zoom:  Found in the Document View menu  
 

 



 

LEAP 2025 Online 
Line Guide 

 
  

The Line Guide tool provides a horizontal line that brings 

focus to a single line of text.   To use the Line guide, click 

on the Line Guide button.  A single blue line with a blue 

“handle” will appear.  Click on either the line of the 

handle and use your mouse to move the line or handle up 

or down.  

 

 

Kurzweil 3000 Desktop 
Dual Highlighting 

 
When reading, Kurzweil 3000 uses dual highlighting to bring focus to a specified unit of text.  In 
the screenshot below, a single sentence is highlighted and each individual word is highlighted as 
its read.  

 

 
 

 
Kurzweil3000.com:  Dual highlighting during reading shown below.  The Reading Unit and 

Reading Mode can be changed under Audio Options. 

 

LEAP 2025 Online 
Background Color Settings 

 

 
 
To change color options, the student clicks Options/Color 
Choices. From there, the background color of the 
document can be changed to the user’s preference. 
 

Kurzweil 3000 Desktop 
Background Color Settings 

 
To change the K3000 background color options, users can go to Tools/Options/Image and change 

the background color.   The Background Color  button can also be added to the left toolbar 
(for easier access).  To do so, right click on the toolbar, click “insert” (at beginning/end or 
before/after), click “Tools”, then click “Change Background Color”. This will add the tools for 
students to change the color of the background.   
 



 

 
 

 
 

 
 

Kurzweil3000.com :  Background color can be changed under the Document View menu  

 
 
 

  
 

 
 
 



 

LEAP 2025 Online 
Highlighter and Eraser 

 

 
 
In LEAP 2025 Online, students select “Use Highlighter” 
and then click/drag over the text they wish to highlight.  
To remove highlights, select “Clear All.”   

Kurzweil 3000 Desktop 
Highlighter and Eraser 

 

 
 
In Kurzweil 3000, students can select the highlighter or eraser in the left toolbar and click and 
drag over the text to Highlight or Erase highlight. Additional highlight colors, blue and red circle 
tools, and the cross out tool are all available under the Highlight button. 

 
 

Kurzweil3000.com: highlighters, circle tools, cross-out are under the Highlight button. 

 
 

 
 
 

 

LEAP 2025 Online 
Sticky Note 

 

 
 

Kurzweil 3000 Desktop 
Sticky Note 

 

 
 



 

 
 
The Sticky Note allows users to place a short note almost 
anywhere within the window that contains a question, 
passage, or scenario.  Use a note to mark a special part or 
to leave a reminder of some important information in a 
question, passage, or scenario. 

 
 
 
Students can use sticky notes in Kurzweil3000 to take notes while reading and can be placed 
almost anywhere within the document.   To delete a sticky note, right click on it, then select 
“delete note.”  Or click in the sticky note and then click on the “Delete Current Note” button in 
the toolbar. (Note: in the screen shot above, the background color has also been changed. 

 
 
Kurzweil3000.com: sticky notes, text notes and bubble notes can be found under Notes. 

   
 

 



 

LEAP 2025 Online 
Cross Off Tool 

 

 
 
Allows users to use process of elimination when trying to 
select answers. 
 

 
 

Kurzweil 3000 Desktop 
Cross Out Tool 

 
 

 
 

The Cross Out tool works very much like a highlighter and can be used for process of elimination 

when trying to select answers.  Select the tool and then click/drag over the text that you wish to 

“cross out.”  The Eraser tool will erase cross outs.   

 

Kurzweil3000.com: highlighters, circle tools, cross out are under the Highlight tool 

 

 

 

 

 

 

After bringing an image document into Kurzweil 3000, either through scanning, the KESI Virtual Printer (available in desktop software), or by 
opening an existing image (pdf, jpeg, png) file, you will often need or want to perform some document preparation tasks. Document preparation 
consists of editing a document for optimum reading by Kurzweil 3000 to insure proper reading order and pronunciation. Document editing can be 



 

done in Kurzweil3000.com and in the Kurzweil 3000 Desktop Software.  Instructions for both are included below, with Kurzweil3000.com being 
presented first.  
 

Kurzweil3000.com Document Editing for Optimum Reading Accuracy 

(Especially Important for Test-Taking) 

Task Instructions 
Locate the 
document 

Locate the document that you wish to bring into Kurzweil3000.com as an image document.  If it is not a PDF, jpg, or 
png, open the document in its original application (i.e. Word, PowerPoint, etc); go to File/Save As, and save the 
document as a PDF.   
 

Login Login to Kurzweil3000.com (www.kurzweil3000.com) 
 
 

Bring the document 
into 
Kurzweil3000.com 

Open the desired image document using the following buttons: Google Drive, Computer, or Upload.  (If you select 
Computer, the document will open and be automatically saved to your Recently Opened Local Files Folder.  To select 
Upload, you’ll navigate to the folder in which you wish to save the document (your Private or Public), then click 
Upload.  The document will not open, but will be uploaded to the specified folder.  To open it, navigate to the 
document and open it.  
 

 
 
Save:  As a teacher, it is wise to save a copy of the original document in your Private folder or other location that is 
inaccessible to students.  You can use the Copy button to create an additional copy of the file to manipulate. 
 

Read/Listen 

 
 
Audio Options 

 

Listen to Kurzweil 3000 read the document aloud so that you can identify potential reading errors.  
 
 
 
You may wish to turn up the reading speed while reading to hear errors, as you are not reading for understanding, but 
only to pick up on errors.  Adjust reading speed, etc under Audio Options.  
 

file:///C:/Users/Missy%20Tatum/Dropbox/Testing%20Info/www.kurzweil3000.com


 

Edit for Optimal 
Reading Accuracy 
 

 
Tools Menu 

The Zone Editor and the Edit Underlying Text editor are both located in the Tools Menu.  Note: These are tools that 
can be locked for students under My Account/Users/My Team/Miscellaneous Feature Locks. 
 
The document must be in one of your folders in order for you to edit with either the Zone Editor or Edit Underlying 
Text.  

 
 

Zone Edit the 
Document    
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Zones determine what is read and reading order in an image document. The Zone Editor allows you to change the 
properties and reading order of zones, adjust the size of a zone to determine how much text it encloses, add new 
zones, delete zones, or designate silent zones.   Hovering over a selected zone provides the user with information 
regarding the properties of that zone.  Likewise, hovering over the list of the types of zones in the zone editor on the 
right will also produce a tooltip.  Zones can be moved and resized as needed. Zone editing should be done before 
adding highlights or notes to a document.  The Header/Footer Editor allows you to determine if those will be read.  If a 
zone is not recognized by Kurzweil3000, it may be necessary to Re-Recognize the page.  Override OCR allows you to 
type what you want to be said without having to change the text one number or word at a time, handy to use with 
math editing.  
 
 

 
 



 

Edit Underlying Text    
 
 
 

  
 
 

The Edit Underlying Text feature allows users to correct pronunciation in image files.   When activated, the underlying 

text file that Kurzweil 3000 is actually reading will show at the bottom of the screen.  The user selects the word that is 

being mispronounced in the document and then spells out the correct pronunciation in the “selected word” field at 

the bottom.  

 

 
In the example above, the name “Al” (as in Al Capone) was recognized and pronounced as “A1.”  To correct, simply 
type the correct spelling (or, in some cases, the phonetic spelling) of the selected word in the “Selected Word” field at 
the bottom.  Once changes have been made,  close the Underlying Text Windows and save changes.   
 



 

Miscellaneous 
Feature Locks 
 

 

 

 

 

Feature Locks 

To lock Bubble Note Editing, Zone Editor, and Edit Underlying Text for the students on your team, go to My 

Account/Users/MyTeam (it will be yellow)/Miscellaneous Feature Locks. Select those three features, then click Save. 

 

 

Features such as vocabulary supports, spell check and others can be disabled for students on a teacher’s team, which 
is especially helpful in a test-taking situation.  Remember to reset feature locks once the test is completed.  

 

 

Password Protect  
In the View menu 

 

In a test-taking situation, it is a good idea to password protect test documents.  This can be done through the View 
menu/Set Document Password.  This will allow a teacher to copy a secure file into a student folder without risk of it 
being opened.  It is advisable that teachers never give the document password to a student,  but for the teacher to 
input that password.   It is also advisable that the teacher keep a copy of the file that is not password protected in 
her/his private folder or in some other secure location as a backup.  
 
 

 Important Note: There is no way to retrive a forgotten password , so make sure to 
record it reliably.  Passwords can be changed by the owner of the document. 
 
 



 

Copy the document to 

the student folders. 

 

 

 

 

 

Click in the small check box to the left of the document name, then select Copy. 

The document can then be copied to individual student folders or to multiple 

student folders.   To copy to an individual student folder, select Copy then 

navigate to that student’s Public or Private folder (or a subfolder within one of 

those).   By selecting “Copy to Multiple,” teachers can copy a document to 

multiple student folders at one time.   She/he can create a new folder, can copy 

to all students Private folders, or can select specific students to copy to.   

 

 

 

In order to manually select students to copy files to, click on the 

triangle next to the student name to show their Public and Private 

folders. Click in the check box next to the folder in which you wish 

to save.  (Note: if the student has subfolders in her/his Public 

and/or Private Folders, click on the triangle next to the folder to 

reveal the subfolders. 

 

 

 

 

 

 

 

 



 

To share a test with students andhave them access the teacher’s annotations (bubble notes, text notes, sticky notes) to 

answer questions, and collect them all into a single file: 

In the Universal Library, click in the checkbox next to the file name. Select Copy/Copy to Multiple and save in your (the teacher’s) 

Public      Folder.  Under  Annotation Source, choose Owner to keepyour annotations attached to the test.  Then click Copy.  Once 

the students have answered the questions, the teacher can open the document, go to the Highlight menu/Extract Notes and 

Highlights. Click Advanced to select which annotations are to be extracted, click Users to select desired users, then click OK. This 

will extract the students annotations into a separate doc ument organized by user.  

 

 



 

 

Kurzweil 3000 Version 16 Desktop Software Document Editing for Optimum Reading Accuracy 

The instructions on the next several pages do not pertain to computer-based tests, but to documents (including tests) that are in digital format or hard copy, 
which are brought into the Kurzweil 3000 Desktop Software.  After you have a brought a document into Kurzweil 3000, either through scanning, the KESI Virtual 
Printer, or by opening an existing image file, you will often need or want to perform some document preparation tasks. Document preparation consists of editing 
a document for optimum reading by Kurzweil 3000 to insure proper reading order and pronunciation. 

 

Step Task Instructions 

Step 1 Bring the document 
into Kurzweil 3000 
through scanning, 
virtual print, or 
opening a PDF.   

Virtual printing allows you to bring virtually any electronic document into Kurzweil 3000.  To virtually print, open the document 
in its original application (i.e. Word, Powerpoint, etc).  Go to Print and change your Printer to the KESI Virtual Printer.  If the 
document is in color and you wish to bring it into Kurzweil in color, select color from your printer properties. To scan a document 
into Kurzweil, open Kurzweil, put the document on your scanner, then click the Scan button. If you wish to Scan in color, go to the 
Scan menu and select color scanning. To open PDF files into Kurzweil, open Kurzweil 3000, go to Open, navigate to the PDF File 
and open it.  Kurzweil 3000 will ask that you specify a page range.  This is a great way to create separate files for chapters, etc.  

Step 2 Save the 
document.    

Very Important: Save periodically throughout the editing process to insure that all changes are saved.  You will also want to have 
the test read aloud in Kurzweil as you go.  (If you’re using Kurzweil 3000+firefly, you will may wish to save to your Universal 
Library.) 

Step 3 Select the Scan Tab 
at the top of the 
screen. Then select 
the Zone Editor. 

The Zone editor can also be accessed via the Scan Menu or by using the keyboard shortcut (Ctrl + F5) to toggle on/off. 

 
 

Step 4 Zone Edit the 
Document    
 

 

The Zone Editor allows you to change the properties and reading order of zones, adjust the size of a zone to determine how much 
text it encloses, add new zones, delete zones (so that the text isn’t read).When the Zone Editor is Active, the document appears 
in the Zone Edit View.   Double clicking on a zone allows you to change reading order, change the zone to silent reading, etc. 
 



 

 

Left click on a zone to select it, then right click to see the Zone Editor shortcut menu.      
(The Zone Editor can also be found in the Scan Menu and can be toggled on/off using the keyboard shortcut Ctrl + F5.)  

Step 5 Header Footer 
Editor   
 

 

Header/Footer Editor allows you to mark the Header or Footer once in a document and prevent it from being read throughout 
the document, given that it’s in the same location on each page.  (This can be accessed through the Scan Menu/Header Footer 
Editor or using the keyboard shortcut Ctrl + F8 to turn it on/off.) 

Step 6 Edit Underlying 
Text    
 

 
 
 

The Edit Underlying Text feature allows you to correct pronunciation errors and insure that words are read aloud correctly.  (Can 
also be accessed thru the Edit Menu/Correct Recognition/Edit Underlying Text or by right clicking next to the word that you wish 
to correct.) You may also wish to use Edit/Find/Replace if you have multiple occurrences of a word that you wish to correct 
throughout a document. 
*Note:  To make Kurzweil pause in appropriate places as it reads, you may wish to do the following: 

 Place a period after headings, labels in a graph, after multiple choice answers, etc. 

 In a multiple choice question, when editing the underlying text, put a semicolon after the answer letter “A,” then a 
comma after B, C, D, E 

Step 7 Run Spell Check     
 

 
 

Spell check (located in the toolbar to the left of the document window) will allow you to identify and correct some of the 
recognition errors.  (Spell Check can also be found in the Tools Menu and can be accessed using the keyboard shortcut Shift + F8.) 
You can also do a Find /Replace to change multiple occurrences of a word. Edit Menu/Find/Replace Text (or Ctrl + H). 



 

Step 8 Read the document 

    

Listen to the document being read aloud to insure that it is reading correctly and in the proper order.  You can adjust reading 
speed by going to the Read Menu/Reading Speed.  Or you can increase with F11 and decrease with F12.  It’s important to have 
Kurzweil read the document as you go thru the editing process so that you can hear what the students will hear as they use 
Kurzweil to read the materials out loud.    

Step 9 Set Page numbers 
so that they are the 
same as the page 
numbers in the 
original document. 

Go to View Menu/Page/Set Number.  Use the Set Page Number dialog box, to renumber a document's pages by changing the first 
page number, or to designate a number of pages at the front of a document as Front Matter.  Save. 

Step 
10 

Lock (Disable) 
Features 

Features such as vocabulary supports, spell check and others can be disabled, which is especially helpful in a test-taking situation.  
Select Tools menu/Lock Features.  Select the desired features you would like to disable.  This locks those features for that 
computer.   

 

 

To save your features locks to a document, go to File/Properties/select Save Feature s Locks in the document.    You can also 
Password Protect a document from this dialogue box.  See section below. If you wish to password protect, do not lock “File 
Encryption” under the Miscellaneous category. 

 



 

 

 

Feature locks can also be applied at the user/account level in the Kurzweil3000.com (firefly).  Log into the Kurzweil3000.com 
(www.kurzweil3000.com), go to My Account/Users/My Team/Feature Locks.  These will apply in firefly, K3000 for Windows, 
K3000 for Mac.  Features locks can be customized for specific students or can be set for all students on a team.  

 

 

 

Step 
11 

Password Protect 
the file.  This will 
require a password 
to open the 
document.   Most 
often used for test 
taking.  

Go to File/Properties/ Password for Opening.  Enter a password in the field. (If you haven’t run updates on Kurzweil 3000, you 
might see a button that says “File Encryption.”  Click that and enter a password.  
 

http://www.kurzweil3000.com/


 

 
 
Important Note: There is no way to retrive a forgotten password , so make sure to record it relieably.   

The Help Menu in Kurzweil 3000 has more detailed information on editing of image documents, under the Document Preparation Section.  You may also search 

for terms such as Zone Edit, Edit Underlying Text, Lock Features, etc in the search box in Help. 

There are also some helpful instructional videos available:  

 Detailed video from Audio Optical Systems showing document editing and more in Kurzweil 3000: http://www.kurzweilaustin.com/videossupport1.html  

 Kurzweil Academy: a learning resource on the Kurzweil Education Website: https://www.kurzweiledu.com/kurzweil-academy/kurzweil-academy.html 

http://www.kurzweilaustin.com/videossupport1.html
https://www.kurzweiledu.com/kurzweil-academy/kurzweil-academy.html

